
IThermal Advantage GETTING STARTED GUIDE

Thermal
AdvantageTM

Getting Started
Guide

PN 925901.001  Rev. D
Issued July 2000



I I Thermal Advantage GETTING STARTED GUIDE

© 1999, 2000 by TA Instruments
109 Lukens Drive
New Castle, DE  19720

Notice

The material contained in this manual is believed adequate for the intended
use of this instrument.  If the instrument or procedures are used for purposes
other than those specified herein, confirmation of their suitability must be
obtained from TA Instruments.  Otherwise, TA Instruments does not guarantee
any results and assumes no obligation or liability.  This publication is not a
license to operate under or a recommendation to infringe upon any process
patents.

TA Instruments Instrument, Data Analysis, and Utility Software and their
associated manuals are proprietary and copyrighted by TA Instruments, Inc.
Purchasers are granted a license to use these software programs on the
instrument and controller with which they were purchased.  These programs
may not be duplicated by the purchaser without the prior written consent of
TA Instruments.  Each licensed program shall remain the exclusive property of
TA Instruments, and no rights or licenses are granted to the purchaser other
than as specified above.
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TA Instruments License Agreement

This License Agreement is your proof of license.  Please treat it as valuable property.

This is a legal agreement between you (either an individual or an entity) and TA
Instruments.  By breaking the seal on your disk/CD-ROM package and/or loading
this software, you agree to abide by the terms and conditions of this agreement.
Failure to comply with the terms of this license terminates the agreement and your
rights to use this software.

TA Instruments Software License
1. GRANT OF LICENSE.  This TA Instruments License Agreement (�License�) per-

mits you to use one copy of the specified version of the TA Instruments software
product identified above (�SOFTWARE�), provided the SOFTWARE is in use on
only one computer at any time.  If you have multiple Licenses for the SOFTWARE,
then at any time you may have as many copies of the SOFTWARE in use as you
have Licenses.  If the anticipated number of users of the SOFTWARE will exceed
the number of applicable Licenses, then you must have a reasonable mechanism or
process in place to assure that the number of persons using the SOFTWARE
concurrently does not exceed the number of Licenses.

2. COPYRIGHT. The SOFTWARE is owned by TA Instruments or its suppliers and is
protected by United States copyright laws and international treaty provisions.
Therefore, you must treat the SOFTWARE like any other copyrighted material (e.g.,
a book or musical recording).

3. OTHER RESTRICTIONS.  This TA Instruments License Agreement is your proof of
license to exercise the rights granted herein and must be retained by you.  You may
not rent or lease the SOFTWARE, but you may transfer your rights under this
License Agreement on a permanent basis provided you transfer this License Agree-
ment, the SOFTWARE, security key(s), and all accompanying written materials and
retain no copies, and the recipient agrees to the terms of this Agreement.  You may
not reverse engineer, decompile, or disassemble the SOFTWARE.  Any transfer of
the SOFTWARE must include the most recent update and all prior versions.

4. NO WARRANTY:  The software and documentation are provided on an �as is�
basis and all risk  is with you.  TA Instruments makes no warranties, express,
implied, or statutory, as to any matter whatsoever.  In particular, any and all warran-
ties of merchantability, fitness for a particular purpose or non-infringement of third
parties rights are expressly excluded.  Further, TA Instruments makes no represen-
tations or warranties that the software and documentation provided are free of
errors or viruses or that the software and documentation are suitable for your
intended use.

(continued on next page)
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LIMITATION OF LIABILITY:  In no event shall TA Instruments or its suppliers be
liable to you or any other party for any incidental, special, or consequential dam-
ages, loss of data, or data being rendered inaccurate, loss of profits or revenue, or
interruption of business in any way arising out of or related to the use or inability to
use the software and/or documentation, regardless of the form of action, whether in
contract, tort (including negligence), strict product liability or otherwise, even if
any representative of TA Instruments or its suppliers has been advised of the
possibility of such damages.

This License Agreement represents the entire agreement concerning SOFTWARE
between you and TA Instruments.  It supersedes any prior proposal, representa-
tion, or understanding between the parties.
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TA Instruments Offices

For technical assistance or
service in the United States:

When contacting TA Instruments, please have your controller key number or
computer serial number ready.  This helps us to give you the information that
you need more quickly.

TA Instruments, Inc.
109 Lukens Drive
New Castle, DE  19720
Telephone:  1-302-427-4000 or 1-302-427-4040
Fax:  1-302-427-4001

HELPLINE—U.S.A.
For technical assistance with current or
potential thermal analysis applications,
please call the Thermal Analysis Help Desk
at 1-302-427-4070.

SERVICE—U.S.A.
For instrument service and repairs,
please call 1-302-427-4050.

TA Instruments Ltd.
Europe House, Bilton Centre
Cleeve Road
Leatherhead, Surrey KT22 7UQ
England
Telephone:  44-1372-360363
Fax:  44-1372-360135

PN 924000.901
SN 4000–4L0638
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TA Instruments GmbH
Max-Planck-Strasse 11
D-63755 Alzenau
Germany
Telephone:  49-6023-9647-0
Fax:  49-6023-9647-77

TA Instruments Benelux
Ottergemsesteenweg 461
B-9000 Gent
Belgium
Telephone:  32-9-220-79-89
Fax:  32-9-220-83-21

TA Instruments Japan
No. 5 Koike Bldg.
1-3-12 Kitashinagawa
Shinagawa-Ku, Tokyo 140
Japan
Telephone:  813/3450-0981
Fax:  813/3450-1322

TA Instruments France
B.P. 608
78056 Saint-Quentin-Yvelines
Cedex
France
Telephone:  33-1-30-48 94 60
Fax:  33-1-30-48 94 51

TA Instruments Spain
Waters Cromatografía, S.A.
División TA Instruments
Avda. Europa, 21.  Pta. Baja
28108 Alcobendas
Madrid, Spain
Telephone:  34-91-661-8448
Fax:  34-91-661-0855

TA Instruments Australia
Unit 3
38-46 South Street
Rydalmere NSW 2116
Autstralia
Telephone:  61-29-9331-705
Fax:  61-29-8981-455

TA Instruments Italy
Division of Waters SpA
via Achille Grandi 27
20090 Vimodrone (MI), Italy
Telephone:  39-02-27421-1
Fax:  39-02-250-1827
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Windows NT® is a trademark of the Microsoft Corporation.
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Using This Guide

This guide provides detailed information on installing the TA Instruments
Thermal Advantage software and basic operational instructions.

The following information is presented:

• system requirements
• about Thermal Advantage
• loading instrument software
• using programs on Windows® NT
• basic information on using Thermal Advantage Instrument Control
• general information on how to use Thermal Advantage Universal Analysis.

Windows® is a trademark of the Microsoft Corporation.
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Notes, Cautions, and Warnings

The following conventions are used throughout this guide to point out items of
importance to you as you read through the instructions.

A NOTE highlights important information about equip-
ment or procedures.

A CAUTION emphasizes a procedure that may
damage equipment or cause loss of data if not
followed correctly.

A WARNING indicates a procedure that may be
hazardous to the operator or to the environment if
not followed correctly.
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Chapter 1
Installing Thermal Advantage

Welcome

Thank you for purchasing TA Instruments Thermal Advantage.  Thermal
Advantage makes it easy for you to set up and control the various thermal
analysis instruments that are available from TA Instruments through the use
of familiar tool bars, menus, and windows.

A unique and comprehensive data analysis program enables analysis of data
from any TA thermal instrument.

If you need help or information while using your Thermal Advantage software,
context-sensitive help is available, as well as a comprehensive online manual.
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System Requirements

Installation and use of TA Instruments Thermal Advantage depends on the
appropriate hardware, configurations, and software.  If you need to obtain any
of the items listed below, contact your TA Instruments representative.

Hardware and Other Software

You will need to have the following:

• A personal computer that runs Windows® NT Version 4.0 or higher.
(Service Pak 4 or higher for Windows NT® V4.0 is required.)

• 90 to 100 MB of fixed disk space above that required by NT.  An
additional 640 MB of fixed space is needed to install the optional
instructional videos.

• A two-button mouse or other pointing device.

• A National Instruments GPIB board (PCI, PCMCIA, or AT-GPIB, or ISA
card) and driver software, if you will be running the instrument controller
component of Thermal Advantage.

• Thermal Advantage system and/or remote key.

Windows® is a trademark of the Microsoft Corporation.
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Starting Windows NT®

Logging on is the process used to identify yourself to the computer by entering
your name and password.  This will identify you as an authorized user and
helps maintain security.

To log on to Windows NT, press CTRL + ALT + DELETE when you see the
Begin Logon dialog box.

When you receive your controller from TA Instruments, the user name on the
Logon Information window will be “Administrator” with no password.  You
can establish or change the user accounts by accessing Programs\Admin
Tools\User Manager menu from the Start menu.
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Loading the
Instrument Software

To properly configure the instruments with the controller, you will need to
load new instrument software now and periodically thereafter, as  new
updates are received.   Use the SCROLL key on the instrument keypad, if
available, to access and view the software version currently loaded in your
instrument.  Check this against the latest version. If you need to update the
software, follow these directions:

NOTE:  Instruments that do not have the proper version
of the software will not configure with the controller.

CAUTION:  This procedure will return the instru-
ments to their default settings (for Experimental
and Instrument Parameters).  The method(s)
stored in the instrument will be lost, along with the
following calibration parameters:

� Temperature Calibration Table* (exception:  DSC
2920)

� Cell Calibration* for DSC 2910/2010 and TMA 2940
� Tare for TGA 2950/2050 and SDT 2960
� DTA Baseline Calibration* for SDT 2960
� Probe Calibration for TMA 2940
� Clamp Calibration for DMA 2970
� Sensor Calibration* for DEA 2970

* You can preserve these calibrations by writing
them down before downloading the new instru-
ment software, then reentering the values.

1. Check that the instruments are connected to the controller properly, and
that their POWER switches are turned on.

2. Press and hold the STOP key on the instrument keypad while you press
the instrument Reset button or turn the instrument on.  (See the instrument
operator’s manual for their location.)
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3. Continue holding the STOP key until the instrument display reads
“Module loader Vx.x” or the Ready light comes on.  The instrument will go
offline with the controller, if it was previously online.

4. Start the Instrument Control program.  (If the Instrument Control window
is already open, select Instruments/Reconfigure.)  The system will
automati-
cally
display a
window
such as the
one shown
here (it may
differ
depending
upon the
instrument).

NOTE:  The default directory is Program Files\TA
Instruments\Thermal Advantage\ldr.  If you are instal l ing
Modulated TGA software, access the MTGA subdirectory
located in the ldr directory.

5. Select Start.
Download-
ing of the
instrument
software
will begin
as a
window is
displayed
tracking the
progress
(shown here).

When the downloading has been completed,
the instrument will go offline and a message
will appear as seen in the figure here.

Advantage
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6. Select OK to clear the message.

7. Repeat steps 1 through 6 for each instrument and then reconfigure the
instruments online with the controller.  (See Chapter 3 or the online
documentation to reconfigure the instruments with the controller.)

NOTE:  It is normal to see an Error 15 on the instrument
after new instrument software has been loaded.  Press
the STOP key on the instrument keypad to clear the
e r ro r .
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Chapter 2
Thermal Advantage
and Windows NT®

Basic Windows NT
Program Operation

The TA Instruments Thermal Advantage software operates on a Windows NT
operating system.  For this reason we will briefly discuss some of the more
common operations that you will be using during program operation.  For
more details refer to the literature and online information accompanying the
operating system.

Windows® is a trademark of the Microsoft Corporation.
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Opening the Thermal
Advantage Programs

The Thermal Advantage programs are opened and closed the same way any
other NT program is handled.

To open a program, use the Start/Programs/TA Thermal Advantage menu or
establish a program shortcut as instructed in the Windows NT® literature.
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Closing a Thermal
Advantage Program

To close a Thermal Advantage program, click on the close (X) button in the
upper-right corner of the main window or select Close from the drop-down
menu (displayed when you click on the program icon button in the upper-left
corner of the main window).  See the figure below.

Drop-down Menu Close Button
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Switching Between
Thermal Advantage Programs

To switch between Instrument Control and Universal Analysis, click on the
taskbar button representing the program that you want to use.

If you are running one of the DOS data analysis programs, use Ctrl-Esc to
return to the desktop or Crtl-Tab to switch programs.

NOTE:  To get more detailed information regarding
these procedures, see the Windows NT® literature.

Locating Advantage Files

When you start to use the Thermal Advantage programs, you will need to use
specific directories or folders to store and retrieve your procedure, data,
sequence and method files.  To locate these files, follow the instructions found
in the Windows NT literature.  You can locate files using the My Computer
icon on the desktop.  The TA Instruments data files are stored in the
TA\DATA\[Instrument] directory, unless you have changed this setting using
the Tools/User Preferences properties.
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Using Pop-up Menus

Throughout the Thermal Advantage program there are several pop-up menus
that can be used to edit fields and perform various functions. To display pop-
up menus:

1. Position the pointer on the field or in an empty area of the window.

2. Click the right mouse button.

NOTE:  The contents of a pop-up menu can change
depending on the window, location of the pointer in the
window, or the current state of the window.

Arrows to the right of a menu choice (as shown here)
indicate that there are additional menu choices available.
A series of dots after the menu name indicates that selecting
this menu item opens a window.
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Chapter 3
Getting Started with
Instrument Control

Overview

Before you begin this section, we recommend that you familiarize yourself
with the basic operation of the Windows NT® system.  Refer to Chapter 2
of this guide for a few general tips to get you started.

This chapter provides you with a brief explanation of Instrument Control
and general guidelines for setting up an experiment. For further details
refer to the online manual that accompanies the Thermal Advantage soft-
ware (accessed by selecting Help/Manual).
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Instrument Control Basics

Instrument Control allows you to control and set up the instruments that
you have connected online to the controller.

Before starting Instrument Control, check that the instruments are con-
nected to the controller and their POWER and HEATER switches are
turned on.  For further details regarding the connection and operation of
the instrument refer to the appropriate instrument operator’s manual.

To start Instrument Control, select Start/Programs/TA Thermal Advan-
tage/TA Advantage Control or double click on the program shortcut (if
available).  The following steps occur:

• The program first checks to see that you have properly installed the
Thermal Advantage key (see Chapter 1 for details).

• The Controller window appears and automatically configures any
instruments that are online with the controller. When instrument
windows are displayed, the Controller window appears as a
background window with a menu across the top.  See page 3-5 for an
illustration.

• The Instrument Control window(s) for any instruments online with the
controller are displayed within the main Controller window.  Each
instrument window title bar identifies that instrument type as well as
the GPIB address.  If no Instrument Control windows appear, follow
the directions on page 3-3 to reconfigure your instruments.

This chapter gives you basic information on each of these windows.
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Main Controller Window

The Controller menu, displayed at
the top of the Controller window,
is used for overall control of the
instruments online.  You can
configure instruments online, see
an overview of the instrument status, switch between the instrument
windows, and close the program.

If your instrument windows are not automatically opened with the Con-
troller window, follow the instructions below to bring them online.

Bringing Instruments Online

Select  Instruments/Reconfigure from the  Controller menu. All of the
instruments that are powered up and connected to the controller will be
reconfigured and brought online. (Each instrument online must have a
unique GPIB address between 1 and 9.) The Reconfigure function is also
used to bring an instrument online in the Loader Mode to install new
instrument software.

NOTE:  Instruments that do not have the proper level of
instrument software may not come online.  You need to
install new software for those instruments.  Refer to
Chapter 1 for software installation instructions.

NOTE:  DSC Autosampler Configuration Only:  If you are
configuring a DSC Autosampler, a GPIB buffer cable is
required.  Contact your service representative to obtain
this buffer cable (only one cable is required per appli-
cable control ler).
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Observing Instrument Information

You can configure from one to eight instruments online with the controller
at one time.  To view the status of all instruments that are online, select
Instruments/Overview All Instruments from the Controller menu to
display the Overview All Instruments window.  This window provides
several viewing options.  See the online documentation for further details.
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Instrument Window

Once you have configured your instruments online with the controller, you
should see a display that is similar to the one shown here.  This figure
shows the parts of the window (DSC is the example shown), which will be
explained briefly in this section.

Instrument windows are basically divided into 3 sections:

• The left pane displays the sequence (or run) list.

• The middle pane is used to display either the Experimental, Table, or
RealTime Plot views.

• The right side panes contain the signal display information and the
running method information.  The lower right pane shows a
thumbnail view of the realtime plot information when either
Experimental or Table View is displayed.

Controller
Menu

Instrument
Menu

Tool Bar
(DSC Shown)

Sequence
Pane Experimental

View Pane

Signal
Display
Pane

RealTime
Plot Pane

Instrument
Task Bar

Running
Segment
Pane
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Switching Between
Instrument Windows

There may be one or more Instrument windows displayed within the
Controller window at one time.  The window title bar identifies the instru-
ment type.  To switch between windows you can just click on the desired
window, if visible, or use the Windows menu.  In addition, an instrument
task bar is displayed at the bottom of controller window to facilitate quick
switching between the instrument windows.  Positioning the mouse
pointer over one of the instrument icon displayed in the task bar will show
the complete instrument identification (mode, instrument model, and GPIB
address).  Clicking on the current instrument window (e.g., indented icon)
will minimize that instrument window.
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Functions of the Panes

Each window pane allows you to perform certain functions while keeping
other operations in view. The basic function of each pane is described as
follows:

Sequence Pane

The Sequence Pane (available in multi-run mode only)
displays the list of runs that are contained in the current
sequence.  Up to ten runs may be preprogrammed (up to 65
for autosampler instruments).  The run with the arrow next
to it is the scheduled run, the run that will execute when
Start is selected.  Buttons are available in this pane to add
and delete runs in the sequence.

Experimental View Pane

The Experimental View Pane contains the complete sample
and procedure information for each run contained in the

sequence.
The infor-
mation that
is currently
displayed is applicable to
the selected (i.e., high-
lighted) run number on
the Sequence Pane.  Use
this view as the primary
view to set up experi-
ments (Experimental
View—Summary Page
shown here).  See “Pro-
gramming the Experi-
ment” on page 3-14 for
information on setting up
each page of the Experi-
mental View Pane.
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Table View Pane

The Table View provides an alternative to the Experimental View for
setting up and editing sample information for a sequence of runs.  Use this
view to change key sample information for each run in a spreadsheet
format, except
for the instru-
ment mode.
The best way
to use this
view is to
completely set
up one run
using the
Experimental
View.  Then
you can use
the same procedure on other samples by simply changing the sample
information.  The specifics of the selected procedure cannot be changed in
this view (switch to Experimental View to change the procedure).

Signal Display Pane

If you want to view the instrument’s
output signals, use the Signal
Display Pane.  See the help system
for an explanation of these signals.
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Running Segment Pane

When a run is in progress,
you can see which method
segment the instrument is
processing in the procedure
by viewing the Running
Segment Pane.  To modify the
running procedure, right click
inside this pane to open a
pop-up menu and click on
Modify Running Method or Go To Next Segment.  For more information
on this function, consult the online documentation.

RealTime Plot Pane

To watch the data points as they
are collected from the instrument
during a run, look at the RealTime
Plot Pane.  You can customize the
way the plot is displayed by
changing the axis signals, colors
and fonts used.  Right-click inside
the RealTime Plot Pane to display
the menu available for these
functions.

NOTE:  You can resize all of these panes just like you
resize windows, by pulling the sides or corners using the
double-headed arrows. When you close the Advantage
program, the views and pane sizes are automatically
saved for future recall.
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Tool Bar & Instrument Menu

The tool bar provides access to all of the basic controls and windows
necessary to run an experiment.  Each instrument contains an instrument-
specific menu and tool bar to control and set up experiments.  The table
below summarizes each of the items contained on the tool bar.  You can
also access these items and others through the instrument menu.

Button Function

Start:  Use Start to begin an experiment.  Start executes
the first step in the scheduled run.

Stop:  Use Stop to halt an experiment and save the
data. Selected Post Test functions will activate after
this action.

Reject:  Use Reject on the Control menu to halt an
experiment and discard the data.

Hold:  Use Hold to suspend an experiment, maintain-
ing the current temperature conditions, until you
resume or stop the method.

Resume:  Use Resume to continue the method that was
put on hold, continuing with the suspended segment.

RealTime Plot Full Screen View:  Use this button to
display the RealTime Plot window in full screen view.

RealTime Plot Pane View:  Use this button to display
the RealTime Plot window in the middle pane along
with the Sequence Pane, Signal Display Pane, and
Running Segment Pane.

Experimental Pane View:  Use this button to display
the Experimental Pane along with the Sequence Pane,
Signal Display Pane, Running Segment Pane, and a
small (thumbnail) view of RealTime Plot.

(table continued)
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Button Function

Table Pane View:  Use this button to display the Table
View Pane along the Signal Display Pane, Running
Segment Pane, and a small (thumbnail) view of
RealTime Plot.

Mode Parameters: Use this button to open the Mode
Parameters window.

DSC Autosampler Reset:  Use this button to reset the
DSC Autosampler

LNCA/GCA Fill (DSC, DMA, and DEA only):  Use this
button to to have the appropriate cooling accessory
automatically refilled from a low-pressure bulk storage
tank while an experiment is not active.

Calibration Analysis (DSC, SDT, TMA only): Use this
button to access the analysis functions used to analyze
calibration files.

TGA/SDT Tare:  Use this button to automatically tare
the instrument.

TGA Weight Calibration:  Use this button to begin the
weight calibration procedure.

TMA Probe Calibration:  Use this button to begin
calibrating a TMA probe.

DMA Clamp Calibration:  Use this button to begin
calibrating a DMA clamp.

(table continued)
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Button Function

DEA Electronic Calibration:  Use this button to cali-
brate the DEA electronics.

User Preferences:  Use this button to open the User
Preferences window.

Error Log:  Use this button to open the Error Log
window.

Wizard:  Use this button to start the Wizard.

Universal Analysis:  Use this button to open or recall
the Universal Analysis program.
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Basic Experimental Steps

The following steps are a guide for conducting a typical thermal analysis
experiment.  Once you are comfortable with the basic experimental setup,
consult the Thermal Advantage online help for details on the full utilization
of the program.  This guide only presents basic information to get you
started.

1. Select the desired instrument for your experiment (if you are running a
multi-instrument system). To do this, use the Window menu found on
the Controller menu or the click on the desired button on the instru-
ment task bar.

2. Select the instrument mode using the Experimental/Mode menu or

click the  button on the tool bar.

3. Select the desired technique to set up your experiment—click the 

button to access the Experimental View or click the  button to

start the Wizard functions.

4. Set up all the sample and procedure information through the Experi-
mental View.  See “Programming the Experiment” on the next page for
more detailed information.

5. Prepare the instrument (i.e., load pans or cups, tare the instrument,
etc.)

6. Schedule the run.

7. Start the experiment by selecting Control/Start or click the Start button
on the tool bar.

8. Monitor the real-time signals, plot, and method progress.
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Programming the Experiment

To set up your experiment, access the Experimental View by selecting

 from the tool bar or by selecting View/Experimental from the appro-

priate instrument menu. The Summary Page (Dual Sample DSC shown
here) is displayed.

You need to check and update the Summary, Procedure, and Notes pages
with the correct information prior to starting each experiment.  Once this
information is correct, click on either the Apply button to save these
changes or the Append Run button to save these changes and add another
run to the end of the sequence.

For more details on how to use the three Experimental View pages, turn to
the next three sections.
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Using the Summary Page

The Summary Page (shown on the previous page) is used to enter the
basic information needed to create a run. You can set up the sample name,
size (if applicable), pan number (if applicable), and data file; enter com-
ments about the run; turn on the Autoanalyze feature; and choose the test
to be used.

To use the Summary Page, follow these directions:

1. Before setting up your experiment verify that the mode displayed is the
one you want the instrument to use. If the mode is not correct, select

Experimental/Mode from the instrument menu or click the 

button on the tool bar. Then you can select the mode you want to use.

2. Enter the Sample Name.

3. Enter the Sample Size, if applicable to your instrument.

4. Autosampler instruments only:   Specify the Pan No.(s).

5. Enter any Comments.

6. Enter a data filename by clicking on the Browse button to the right of
Data File, then select the desired storage location and enter in a
filename.  Click OK when finished.

7. If you want to automatically analyze the resulting data file using a
macro (created with the Universal Analysis Autoanalysis software
option), check the Autoanalyze box.  Then locate the desired macro
filename using the Browse button.  Click on the Analysis Macro list
and select a macro from those displayed. For more information on
Autoanalysis, see the Universal Analysis online help or manual.

8. DMA instruments only:  Select the clamp to be used from the drop-down
list of available clamps.  (If you change clamps you will be prompted
to perform clamp calibration.)

9. DMA instruments only:  Select the sample shape from the list and enter
the sample’s dimensions in the specified units.
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10. Select the type of test you want to use from the drop-down Test list
available.  The list contains both preprogrammed tests (test templates)
and a custom test.  The option you choose will depend on the specific
method you wish to perform.

11. Check the available template options to see if any of those meet your
needs.  You can view a summary of the chosen procedure by selecting

the  button.  If you want to use your own procedure, rather than a

preprogrammed test, select the Custom test.  This allows you to create
a customized method or to load an existing method file (*.mth).  (To
change any of the information, except for the mode, select the Proce-

dure Page.)  To open a saved procedure file, click the  button.  The
procedure file will be added to the test list once you have selected it.

12. When you have finished setting up this run summary, you should
verify the information contained on the Procedure Page and the Notes
Page.

13. Click the Apply button to apply the information on this page to the
current run.

NOTE:  In the case of a Dual Sample DSC, there are two
Summary Pages, one for each sample.
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Using the Procedure Page

After you choose a
test on the Sum-
mary Page, the
Procedure Page
(shown to the right
with a test selected)
reflects the informa-
tion contained in
that test and will
vary accordingly.

• If you choose
one of the
common test
templates on
the Summary
Page, which are
specific to each
instrument, the
Procedure Page reflects the information that you will need to enter to
set up your run using that test.

•  If you choose a
Custom test on the
Summary Page, you
can switch to the
Procedure Page
(shown to the left
with Custom test
selected) and then
use the Editor button
to make changes to
the method listed.
See “Creating
Custom Methods”
on page 3-22 for
more information.
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To use the Procedure Page, follow these directions:

1. View the current test displayed (you can select a new test on the
Summary Page).

2. Type any notes that you want to write about the test you will be
running, if Custom test was selected.  A preprogrammed test template
will display notes specific to the test chosen.

3. Enter the requested method parameters, if you choose one of the test
templates.  However, if you chose a Custom test, click the Editor button
to display the Method Editor window.  This allows you to create a
customized method or load an existing method file (*.mth).  See “Creat-
ing a Custom Method” on page 3-22 for more details.

4. Click the Advanced button to display the Advanced Parameters
window applicable to the current instrument.  If desired, you can
change the parameters that the instrument will use to perform the
experimental run.

5. Click the Post Test button to display the current Post Test window.  If
desired, you can change the conditions that will apply at the end of
the run (method-end conditions).

6. When you have finished setting up this procedure you should verify
the information contained on the Summary and the Notes Pages.

7. Click the Apply button when finished to save these changes or click
the Append Run button to add another run to the end of the sequence.
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Saving or Viewing a Procedure

To save a test template to a procedure file, click on the  button on the

Procedure Page.  To view a summary of the saved procedure file, open the
Procedure File Utility window using Tools/Procedure File Utility selected
from the instrument menu.

NOTE:  You can use any test template as the basis for a
Custom test by selecting the desired test template from
the list of tests, then click the Apply button and change
the test to Custom on the Summary Page. Then you can
click on the Procedure Page and then the Editor button to
make the changes desired.
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Using the Notes Page

Most instruments have a very similar Notes Page. This page is used to
enter or select additional information to be stored with the data file.

To enter or
select the
additional
information for
your experi-
ment, follow
these steps:

1. Enter the
name of the
Operator
conducting
the thermal
analysis
experiment.
Up to 25
characters
may be
entered.

2. DSC, TGA, and SDT only:  Specify the Pan Type used for this experi-
ment from the list of available pans.

3. TMA only:  Specify the Probe Type used for this experiment from the
list of available options.

4. Enter any Extended Text to include additional information about the
sample or experiment, such as sample treatment or data sampling
parameters. Up to 500 alphanumeric characters may be entered
(approximately 12 lines).

5. Select the primary purge environment (Gas #1) and flow (including
units) used in the experiment from the list of available choices.  If no
purge gas is used, select None from the list.  You may also enter in
your own purge gas name (up to 9 characters).  In DMA, specify the
Air Bearing Gas.
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6. DSC, TGA, and SDT only:  Select the secondary purge environment (Gas
#1) and flow (including units) used in the experiment from the list of
available choices.  If no purge gas is used, select None from the list.

7. Click the Apply button to apply the information on this page to the
current run.

NOTE:  These gas entries do not actually control which
gas is currently flowing through the instrument, but
merely indicate which gases are plumbed to the instru-
ment.  For example, oxidative stability experiments use
nitrogen for the primary gas and oxygen for the second-
ary gas.
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Creating Custom Methods

When you select a Custom test, which lets you set up your own experimen-
tal parameters, you can click the Editor button on the Procedure Page to
display the Method Editor window (shown here).  This window is used to
create a custom method by building or modifying a preprogrammed series
of instructions, called segments, to be executed by the instrument.  The

segments are added, moved, or deleted from the method using the drag-
and-drop technique.  Collectively this group of segments makes up a
method.  Up to 60 segments can be contained in a method.

The next several pages provide you with brief instructions on how you can
handle and manipulate methods.
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Importing/Exporting Methods

You may use the Method Editor window to import (using the  button)

an existing method file to use, or export (using the  button) just the

method portion of the procedure to file.  These last two options provide
compatibility with the previous generation TA Instruments Windows® NT
and OS/2 software.  (When you use the Advantage software, procedure
files replace method files.)

Creating and Editing Files

You can create or open a method file for editing using the Method Editor
window as follows:

1. Click the  button to create a new method, this will clear the exist-

ing name and segment description list to create a new method.
or
Import an existing method, as directed above, to edit a method.

2. Give your method a name, then select and edit chosen segments.  See
the instructions beginning on the next page to manipulate segments.

3. After you finish editing or creating a method, you can save the method

as part of your Custom test using the Save Procedure  button on

the Procedure Page.

Windows® is a trademark of the Microsoft Corporation.
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Adding Segments

To add a segment to any method:

1. Click on the desired segment to be added from the Segment Types list
to highlight it.

2. Use the drag-and-drop method to move the segment:  Hold down the
mouse button while you move the cursor to the desired position in the
list of numbered segments (Segment Description List). Then release the
button.

3. Edit the entry field(s) as desired, using the Tab key to move between
fields.

Appending a Segment

To append a segment to the end of a method, do one of the following:

• Double click on the desired segment to be added from the Segment
Types list.

• Click on the desired segment to be added, then press Ctrl + E to
append it to the method.

• Follow these steps:

1. Click on the desired segment to be added from the Segment Types
list to highlight it.

2. Use the drag-and-drop method to move the segment:  Hold down
the mouse button while you move the cursor to the empty area
under the list of numbered segments (Segment Description List).
Then release the button.

3. Edit the entry field(s) as desired, using the Tab key to move be-
tween fields.
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Removing a Segment

To remove a segment, just highlight the segment in the list and press the
Delete button (or use Ctrl + X).

Editing a Segment

To edit a segment, double click on the segment and edit its parameters (or
select the segment and press Ctrl+E).  Use the TAB key to move between
the parameters.

Reordering Segments

To reorder the segments, just drag-and-drop a segment in a new position
within the segment description list.

Selecting Multiple Segments

Within the segment description list you can select multiple segments for
deletion or copying by holding down the Ctrl key while clicking on the
desired segments.
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Preparing the Instruments

The experimental preparation steps vary for each instrument.  A list of
general guidelines are below, however, you should consult the specific
instrument operator’s manual or online help for detailed instructions.

1. Check that the purge gas is adjusted to the recommended flow rate.

2. SDT and TGA only:  The SDT and TGA instruments both require taring
procedures, using the empty sample pan(s), before loading the sample.
Consult online help for further details.

3. DEA only:  Perform a sensor calibration prior to loading the sample.

4. Prepare and load the sample.

5. DMA and TMA only:  A measure step is usually performed for TMA
and DMA experiments after you load the sample.
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Starting An Experiment

Once the sample has been loaded and the experimental parameters set up,
you can start your experiment in one of four ways:

• Select Control/
Start from the
instrument
menu.  When
you select Start
and there is more
than one run in
the sequence list,
the Start At
window (shown
here) is
displayed to
allow you to
choose the run to
begin.  Click on
the desired run
to move the run
arrow to that run number, then select OK.

• Click on the  button on the tool bar. If more than one run is

contained in the run sequence, the scheduled run (run with the arrow
pointing to it) will be executed.  To schedule a run, prior to starting the
experiment, move the pointer (cursor) along the left of the run
numbers, you should see the pointer change to an arrow. When it
becomes an arrow, you can then click the mouse to position the arrow
next to the selected run number.  This run becomes the scheduled run,
which is the experiment that will be run when Start is selected.

• The scheduled run can also be executed by double clicking on the red
run arrow ( ) in the Sequence Pane.

• Schedule the desired run using the controller software (as outlined
above), then press the START key on the instrument itself.
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Monitoring
Running Experiments

Once your experiment has been started, you can monitor its progress
easily with the Advantage software.  Any one of the four views provide
information regarding the running experiment:

• Click the  to select the Real Time Plot view.  This displays the

Sequence Pane, RealTime Plot, Signal Display Pane, Running
Segment Pane, and the status line.  This view allows you to monitor
alot of information at once.

• Double click on the real time plot to switch to the RealTime Plot Full

Screen view or click on the  button.  This view allows you to

monitor the data as it is plotted.

• Click the  button to select the Experimental View or click the

 button to select the Table View.  These views allow you to

monitor the running experiment while setting up the next run.
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Overview

TA Instruments’ Universal Analysis program allows you to analyze data from
various thermal analysis instruments.  There are options available in the
program that allow you to customize the way the data is graphed and to place
limits on the range of data used for analysis.

The logical order to analyze a data file is as follows:

• Choose a data file
• Verify your sample information
• Draw the graph
• Rescale and customize the graph
• Analyze the data
• View and/or print the results reports.

As you read through this guide, remember that we are presenting basic
information to allow you to get up and running with this program.  This guide
gives you a brief set of instructions to allow you to perform analysis on a data
file.  For further details regarding the use of Universal Analysis refer to the
Universal Analysis online manual or the context-sensitive help associated
with the program.

Chapter 4
Universal Analysis
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Thermal Advantage
Universal Analysis

To start the Universal Analysis program:

Select Start/Programs/TA Thermal Advantage/TA Universal Analysis or
double click on the shortcut icon, if available.  The starting window is dis-
played
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Choosing a Data File

The Thermal Advantage program is shipped with several demonstration data
files that you can use when learning how to operate the software.  We will be
using a demo file called DSC-PET.001 throughout this chapter.

To locate and open a data file on disk follow these steps:

1. Click on  or select File/Open from the main menu, the window

shown here is displayed.

2. Locate the TA\Data\DSC folder to locate the DSC demonstration files.
Select the DSC-PET.001 demonstration file.  Click on this file and a pre-
view of the sample information is displayed, if you have the Preview box
checked.

3. Click Open.  The Data File Information window, shown on the next page,
is displayed.  (To bypass the next window, you can check the Quick Open
box on the window shown above.)
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4. Make any corrections needed to the information displayed on the screen.

5. Click on the Signals button.  The window shown on the next page ap-
pears.
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Selecting Signals

The Signal Selection window (shown here) is used to choose signals that are
used to plot the analysis data.

1. Select the desired y-axis signals to plot and their Type from the drop-down
lists.  In this example, select Heat flow, Normal type for the Y1 signal.

2. Select the desired x-axis signal to plot from the radio buttons displayed at
the bottom of the window. In this example, select Temperature.

3. Click the OK button when you have selected the signals to be plotted. The
window shown on the next page is displayed.

NOTE:  Click the Save button to save the program
parameters listed on this window to the program .ini file.



4�6 Thermal Advantage GETTING STARTED GUIDE

When the
data file
graph is
displayed,
you can
choose to
perform any
 of the
following
actions:

• Rescale
the
graph.

• Limit
the data available for analysis.

• Customize the graph.
• Analyze the data.
• etc.

The capabilities of the Universal Analysis program can be accessed through
the menus or the tool bar.  For more detailed information consult the Thermal
Advantage Universal Analysis online manual.
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Parts of the Window

The Universal Analysis main window provides access to all of the functions
needed to customize and analyze your data file graph.

There may be multiple Data File windows and one curve overlay plot open in
Universal Analysis at one time. The window title bar identifies the data file.
This section gives you basic information on the main window.

You will see references to the window parts shown in the figure below,
throughout the literature and online help associated with Universal Analysis.

Title Bar
Icon Tool Bar

Window Title Bar
Data File
Title Bar

Minimize/
Maximize/
Close Buttons

Main Menu
Data File
Graph
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Main Menu

The main menu is used to access the various
functions that can be performed on the data file.
When you first open Universal Analysis, a limited
menu is available as seen here.

After you have opened a data file (see page 4-3)
the rest of the menu options are available as seen
in the figure below.

The table that follows provides a brief description of the main menu items.

   Menu Description

File Use the File menu to open a data file and perform various
functions such as closing any open windows, saving
analyses, exporting data, printing, etc.

Edit Use the Edit menu to perform various editing functions on
the current graph such as deleting and adjusting results,
and annotating graphs.

Rescale Use the Rescale menu options to change the limit points
and analysis range.  You can change the axis scaling and
zoom in on the portion of the graph that will be analyzed
using these options.

(table continued)
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   Menu Description

Graph Use the Graph menu to select options that allow you to set
up your graphs  by changing signals, units, parameters,
data limits, overlaying curves, etc.

Analyze Use the Analyze menu to choose the type of analysis that
you want to perform on the current data file. This menu
reflects the type of analyses available for the particular
type of data file that is currently active.

Tools Use the Tools menu to select from a list of different types
of functions that can performed on the current graph. You
can smooth, shift, and/or rotate the curve and perform a
linear transformation on either axis. If you change your
mind, you can remove the curve shifts.

 View Use the View menu to view and edit reports .

Window Use the Windows menu to arrange the currently open
windows in different configurations.

Help Use the Help menu to access help topics, an online
manual, and product information.
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Tool Bar

At the top of the Universal Analysis main window is a tool bar that allows you
to perform the same operations found in the menus with the click of a button.
You can customize the tool bar to reflect those options that you use most

frequently by selecting File/Options from the menu (or click the  button)

to display the Main Options window. Click on the Tool Bar page and set up
the desired tool bar items.  The figure above shows the general tool bar setup.
If you have trouble remembering what the icons represent, just position the
cursor over the button and a small rectangle with the name of the button is
displayed.  This is called “flyover help,” and is also set up on the Main
Options window.
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Performing Basic
Program Operations

Three basic operations are explained in this manual:  rescaling, integrate peak
analysis, and obtaining reports.  For further details refer to the Universal
Analysis online manual or context-sensitive help.

Rescaling the Graph

When analyzing data on a curve, it is often easier to zoom in on the portion
that will be analyzed.  To do this you can use zoom box or one of the other
Rescale options.

Using the Zoom Box

The Zoom Box provides the fastest way to rescale.  You can easily expand a
portion of the curve for analysis using the mouse. To zoom in on a particular
portion of the curve for analysis, follow these steps:

1. Position
the
pointer
in the
general
area you
wish to
enlarge
and
hold
down
the left
mouse
button.
As you
move
the
mouse, a zoom box will be drawn from the original point position (shown
above).

Zoom Box
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Move the mouse to draw a box encompassing the area of the curve to be
enlarged.

2. Release
the
mouse. If
the area
selected
is accept-
able,
move the
pointer
inside the
box and
click the
left
mouse
button.
The area
is enlarged as seen in the figure here.

This process can be used repeatedly to expand a smaller portion of the curve.
To return back to the most recent scale changes, press Ctrl-U (Previous Limits).
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Rescaling Using the Menu

You can also perform more specific types of
rescaling operations.  Select Rescale from the main
menu, the submenu shown here is displayed.

Select one of the rescaling options shown in the
menu and described in the table below.

   Menu Item Description

Manual Used to enter numerical values for start, stop, label
interval, tick interval, and label offset.

Cursor Uses graphical cursor entry to rescale the graph.

Zoom Out When you select the Zoom Out option, you will reduce the
image size and make it appear smaller. Click on this
option once to move out one level.

Shortcut Key:  Ctrl-Z

Previous The Previous Limits option redraws the graph
Limits as it appeared before the most recent scale changes. Only

the scaling options selected from the Rescale menu are
affected by this menu option, any changes made in color
or annotation are not affected. Selecting Previous Limits a
second time will return the graph back to the most recent
changes.

Shortcut Key:  Ctrl-U

(table continued)
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   Menu Item Description

Full The Full Scale option redraws the graph as it first
Scale appeared when you generated it from the data file. The

graph is autoscaled to the minimum and maximum data
values for the selected axis only.

Common (Available with 2 or more axes graphed.)
Scale Adjusts all common axes (those with the same units), to

the same scaling magnitude as the selected axis.

Stack (Available with 2 or more axes graphed.)
Axes When you select Stack Axes, the y-axes are adjusted so

that the curves on the axes are stacked, one above the
other, with no curves from one axes overlapping the
curves of another axes.

Exact Check this option to have the axis plotted using the exact
Scaling X range of the x-coordinates found in the data file or rescale

zoom box.  Leave this menu item unchecked and the data
will be autoscaled when applicable. When exact scaling
is not selected, the plot axis is drawn with evenly spaced
axis labels that fall on the corners of the plot. This is the
default setting.

Exact Check this option to have the axis plotted using the exact
Scaling Y range of the y-coordinates found in the data file or rescale

zoom box.  Leave this menu item unchecked and the data
will be autoscaled when applicable. When exact scaling
is not selected, the plot axis is drawn with evenly spaced
axis labels that fall on the corners of the plot. This is the
default setting.
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Analyzing the Curve

To access the Analyze menu, you can:

• Select Analyze from the main menu.  (DSC
Analyze menu shown here.)

    or

• Position the pointer in the graph area
and right click to display the pop-up menu.

NOTE:  The pop-up menu may be
customized by selecting File/
Options/   Pop-Up Menu page from
the main menu.

The general analyze options are described briefly in the table beginning below.
For information on all of the Analyze options, refer to the context-sensitive
help or the manual (Help/Manual) found in the Universal Analysis program.

Option Description

Integrate Calculates the heat of transition, onset temperature
Peak of melting peak, peak maximum temperature, and peak

area.

Peak Determines the height of a peak relative to a linear
Max  baseline.

Glass Determines the glass transition of a polymer or
Transition transition temperature by calculating the onset, end, and

inflection of a step transition.
(table continued)
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Option Description

Onset Determines the onset of any thermal transition
Point that changes the baseline slope.

Oxidation Measures the oxidation onset temperature or
Temp/Time time for a sample held in an oxidizing atmosphere.
(DSC Only)

Slope Calculates the average slope of a selected region of the
curve.

Running Plots the integral of data from another curve.
Integral (Available when the Y-4 axis curve is vacant.)

Curve Value Determines the x and y coordinates for any
at X/Y point on the curve.

Label at Determines the x and y coordinates for any point
X,Y within the graph limits.

Analysis Use the Analysis Range option to set the analysis
Range range from portions of the original x-axis range, thus

confining your data for analysis purposes to the chosen
range. Data outside this range becomes invisible to the
analysis functions, but analyses already performed on
these curves are retained.

NOTE:  Additional options may appear in the analysis
menu based on signal type (e.g., DSC, TGA, TMA, DMA,
and DEA).
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Integrate Peak

In this section we will use the integrate peak linear analysis option to demon-
strate the basic analysis steps.  You can apply these basic steps  to all types of
analyses in the Universal Analysis program.  For further details on analysis
options consult the Thermal Advantage Universal Analysis online manual or
context-sensitive help.

We will use the Analyze/Integrate Peak/Linear option to perform a peak
integration using a linear baseline. A linear baseline is defined as a straight
line drawn between the selected start and stop limits. It is used when the
baseline varies directly (linearly) with time.

1. Click on the appropriate Y-number label displayed above the desired axis
on the graph to select that axis, if more than
one y-axis is displayed.

2. Select Analyze/Integrate Peak/Linear from the main menu, from the pop-

up menu, or click the  button.

The markers are displayed.  (See pages 4-19 and 4-20 for tips on selecting,
positioning, and activating markers.)

3. Double click at the point on the curve where you want the baseline to
begin (before the transition) to position the first marker.  The next marker
becomes active.

4. Double click at the point on the curve where you want the baseline to end
(after the transition) to position the second marker.

5. Right click to display the Analyze pop-up menu
(shown here), then select Accept Limits (or press
Enter). The peak integration analysis results are
displayed.  See the figure on the next page for an
example.
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NOTE:  You can change the parameters of this analysis
by setting the options found on the Analysis Options �
Onset/Peak Integration Page.
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Tips on Using Markers
(Positioning and Selecting)

Markers are lines that are used to select points on a graph during rescaling
and analysis operations.  When using markers, keep in mind the following
tips:

Active vs. Inactive Markers

• Only one marker is active at any time.

• The active marker can be indicated two ways depending on the action or
file:  As a full-length vertical and horizontal line or as a single vertical or
horizontal line.

• Inactive
markers
are gen-
erally seen
as a cross.
See the
figure
here.

Moving
Active
Markers

• To move active markers with the mouse follow these steps:

1. Grab the marker with the left mouse button as follows:  Position the
point at the intersection of the cross or anywhere on the single line.
Press and hold down the left mouse button.

2. Drag the marker to the desired position and release the mouse button.

• To move the active marker with the keyboard, use the right and left arrow
to move the marker or hold down the Ctrl key while using the arrows to
move the marker 10 pixels at a time.

Active Marker

Inactive Marker
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• To move an active marker quickly you can also position the pointer at the
desired location and double click the left mouse button to move the
marker to this point. This action causes the next marker to become active.

Activating a Marker

To activate (select) the next marker you can use any one of these methods:

a. Position the pointer over the inactive marker and click the left mouse
button.

b. Right click to display the Analyze pop-up menu
(shown here) and select the next point from the
menu.

Entering Manual Limits
for Markers

To numerically enter the limits for the marker positions using the keyboard,
follow these steps with the markers displayed on the graph:

1. Right click to
display the
Analyze pop-up
menu and select
Manual Limits
from the menu. The
window shown
here is displayed.

2. Enter the desired
limit points and
click the OK
button.  The analysis is performed using the limits entered and the results
are displayed.
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Printing Plots

You can print plots at any time during your use of the Universal Analysis
program.

To print the plot follow these steps:

1. Select the window containing the curve you want to print.  You can use
the Windows menu or just click on the desired window to select it.

2. Select File/Print from the main menu.  The standard print window is
displayed.  Select the OK button to print using the default printer and the
options shown.

or

2. Click on the    button to print directly to the default printer.
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Generating and Viewing Reports

Universal Analysis contains many different types
of reports that many be viewed, edited, or printed
using the  View menu (shown here).  In addition,
you can create a customized report using the
Custom Report option.  A brief description of all
the View options are listed below.   The items
marked with an asterisk (*) are only available in
Universal Analysis 2000 and require either
Microsoft Word® or Microsoft Excel® to function.

Option Description

Results Use this function to view the results of your
 analysis in a written report form or spreadsheet* form.

Data Table Use the Data Table function to display the sample
information and raw data points from the data file in
either report or spreadsheet* form. For multiplexed data,
such as frequency or amplitude, a separate table is
generated for each multiplexed value.

Parameter Use the Parameter Block function to view a
Block listing of the experimental parameters that were used

when obtaining the data stored in the data file.

Method Use the Method Log function to view a listing of
Log the method segments that were used to obtain the data

file.

Each experimental method is made up of a group of
segments, which are preprogrammed instructions that are
sent to the analytical instrument.

Current Use the Current Macro function to view the list of steps
Macro contained in the currently open macro.
Report

(table continued )
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Option Description

Autoqueue Use the Autoqueue Report function to view the list of
Report records contained in the autoqueue for autoanalysis.

Each record is made up of the data filename, macro
filename, and associated macro.

Autoqueue Use the Autoqueue Log function to view the log of the
Log results obtained during autoanalysis.  Each item in the

log is made up of the pass/fail message, the data file-
name, the macro filename, the associated macro, and a
short comment.

Report Use the Report Editor function to open the Report
Editor Editor program.  (Additional report options are available

with the Autoanalysis option.)

Spread- Use this function to open the Microsoft Excel® program
sheet* with a blank first sheet.

Custom Select View/Custom Report/New to create and edit
Report** customized Universal Analysis report templates.

* Requires Microsoft Excel®, which is a registered trademark of the Microsoft
Corporation.

** Requires Microsoft Word® and Microsoft Excel®, which are registered trademarks of
the Microsoft Corporation.
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Viewing Reports

To view, edit, or print the various types of reports in Universal Analysis follow
these steps:

1. Select the window containing the curve you want to use to generate the
report.  You can use the Windows menu or just click on the desired
window to select it.

2. Select one of the applicable options from the View menu.  (See the table
beginning on the next page for the available View options.)

3. Edit or print the report using the available functions.

See the figure below for an example of the results report.
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Opening the Spreadsheet Program

Use the View/Spreadsheet function to open the Microsoft Excel® program
(which must be present on your system) with a blank first sheet.

NOTE:  If you want to bring the data file into Microsoft
Excel, select View/Data Table/Spreadsheet from the menu.

If you need help using the program, see the documentation provided with the
program.

Creating a Custom Report Template

The Custom Report Editor is used to create and edit customized Universal
Analysis report templates. The templates are created using any number of
report objects such as plots, results, parameters, method log, data tables, etc.
The report object boxes (which represent the plots, results, etc.) can be sized
and positioned as desired to fit on a single piece of paper. After a template file
is created and saved, it can be used over and over again with different data
files and can even be linked to an Autoanalysis macro to further automate the
process of analysis and report generation.

The Custom Report Editor program requires that you have Microsoft Word®
97 or Word 2000 installed on your computer. In order for the spreadsheet
function to operate, Microsoft Excel® must be installed on your computer.

You can create templates that call for only one file or templates that use
multiple files. A template using one file will create the report from the current
file. A template that requires multiple files will prompt you to select the files
desired.

NOTE:  Only one Custom Report window at a time is
available within the Universal Analysis program.

Universal Analysis generates custom report documents by directly running
Microsoft Word and Microsoft Excel from within Universal Analysis. Each
report object inserted is dynamically created at run time and inserted into a
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single integrated Word document. Once the Word document is created, you
can edit any spreadsheets within the document by double-clicking on the
object to open Excel with Word.

You can insert, edit, import, export, and print the report objects using the
menus and tool bar buttons. For further information see the following pages.

Basic Instructions on Creating a Template

There are many different ways to create a report template in Universal Analy-
sis. The set of steps that follows is intended to give you a basic idea of the steps
involved with creating a custom report template.  For more detailed informa-
tion see the online help associated with the program.

1. Open the desired data file(s) and analyze the data to obtain the results you
want.

NOTE:  You can create a report template with no files
open (which creates empty report objects). The report
objects will be filled in when a data file is open and the
appropriate information is supplied. For example, there
can be no results report created if no analysis is done
on the open file.

2. Select View/Custom Report/New from the main menu. The Custom Report
Editor program opens.

3. Select the desired object to insert in your template from the Insert menu or
from the tool bar.

4. Size the object block by positioning the cursor over the border of the block
and hold down the mouse while moving the cursor.

5. Drag-and-drop the object anywhere you desire on the template window.
This window represents an 8 ½ by 11-inch page.

6. Repeat steps 3 through 5 for as many objects as desired. Some objects, such
as Text and Data Table insertion, require that you enter information to
configure that object.
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7. Format the objects as desired. See the figure to the below for an example of
a finished template.

8. Click the   button or

select  File/Save from the
menu to save your template.
Once you save this file, it
will appear in the View/
Custom Report menu as
seen here.

9. Export the report to
Microsoft Word® by

clicking on the  button

or by selecting  File/Export
to Word from the menu. If
you have more than one
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version of an object placed in your template (for example, Normal Plot 1
and Normal Plot 2) the program will prompt you to select the data file that
should be linked to each object. If there is only one data file open, the
program will assume that this is the source for the object.

See the figure below for an example of a finished report.
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Saving the Results
and the Program Session

If you want to save the analysis results or the entire program session in a file,
you can do so.

• Select File/Save Analysis from the main menu to save the current
analyses in the data file for future recall.

• Select File/Save Session from the main menu to save the current state of
the Universal Analysis program to a file for future recall (i.e., curve
overlay plot can be saved).

Exiting the Program

When you have finished analyzing your data, you can exit the program by
selecting File/Exit from the main menu.
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